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Requirements

This exercise requires PC with Windows 95/98 or Windows NT, a scanner and scanner 
software as well as well as the GIS software ArcView 3.1 or later. 

The exercise is adapted for AGFA SNAPSCAN series and the program Agfa Fotolook 
3.00.09. However, any scanner with the ability to save images in TIF format can be used.

Objectives

The aim of this exercise is to familiarise the student with the data capturing technique 
scanning. Knowledge on how to import scanned (satellite) images and adapt them to a 
GIS by rectifying the image will also be gained. The exercise will also introduce the 
ArcView extension module Image Analysis. 

Task

The exercise should result in a scanned SPOT satellite image that has been rectified and 
adjusted in ArcView to be used by the students in a future exercise.

Scanning

Start the scanner by pressing the button on the front. Start Agfa Fotolook by pressing the 
Windows Start button at the bottom of the computer screen and choose Programs and Agfa 
Fotolook. Put the copy of the satellite image facedown on the scanner. Before you can scan 
the image, you must do some adjustments. First, since the satellite image is in black and 
white, you should choose Greyscale in the Mode box. 

Below the Mode box you find the Input box. Here, you can set the resolution at which the 
image will be scanned. The resolution is determined by the number of pixels (short for 
picture elements) that will make up the scanned image. A pixel is a square dot that is the 
smallest unit of a digital raster (or bitmapped) image. Digital images are composed of 
touching pixels, each having a specific colour or tone. A scanner (as well as most other digital
image capture instruments) creates a bitmap by sampling the original and storing each sample 
in a pixel. The higher the resolution of a scan, the more pixels created per area of the original. 
The letters ppi after the number in the Input box is an abbreviation of Points Per Inch and is a 
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measure of resolution i.e. the higher the ppi number the more pixels per inch are recorded by 
the scanner.

It would then seem best to have as high resolution as possible but there are several factors to 
take into consideration first. A higher resolution means that there will be more data, and thus 
the size of the file will be larger and can be difficult for programs and computers to handle. 
Also many programs (or printers if you are going to print your image) does not support 
resolutions higher than around 300 ppi, making it pointless to scan with higher resolution. The
main reason in this exercise for not choosing a very high resolution however is that the 
original, i.e. the SPOT image does not have higher resolution in itself. When the data is 
recorded on the satellite, it is also recorded in pixels and these pixels represent 10 by 10 
metres on the ground. If you look closely at the copy of the image, you can actually see the 
individual pixels. The resolution of the original is approximately 100ppi and you should 
therefore choose this resolution in the Input box.

In the Preview window you find the Size box. Here, you can select a pre-set size for the 
preview window. Set the size to Max. Area and press the Preview button. After the Preview 
is complete, put the cursor in the top left corner until you see the cursor change to a crosshair. 
When you move the crosshair, the selection rectangle changes and you can thus decide the 
area yourself. When you have an approximate area, move the cursor to a side of the selection 
rectangle until you see a double-headed arrow. Then hold down the left mouse button and 
drag until you have the selection rectangle in the exact position you want i.e. all of the 
actual image but not the background.

In the Mode box,
choose Grayscale

In the Input box,
choose 100ppi

In the Size box, choose Max.
area.

Put the cursor in the top
left corner until it is a
crosshair. Drag out the
selection rectangle in the
position you want. Then
move the cursor to the
side of the rectanlge
until you see a double
headed arrow. Drag the
borders of the rectangle
in exact position.
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Now the adjustments are made and you can scan the image by pressing Scan. In the dialogue 
box that appears, navigate to your working directory and save the file in “tif” format. Hint: 
Write down the path to your directory the first time so you don’t have to spend time browsing 
when you need the file the next time.

1. Navigate to your
working directory.

2. Name the file
Spotim.

3. Choose .tif
as file type.

4. Save “To File .”
5. Click OK

Now you are finished with the scanning part so you can close Fotolook.

Working With The Scanned Image

Start ArcView by using Windows Start button and navigating to Programs, ESRI and 
choose ArcView 3.1. When ArcView appears, open a new project with a new view (simply 
click OK in the Welcome box). Say “no” to add data to the view and click on the Project 
window (named Untitled). When the Untitled project window is active, go to the File menu 
and 

choose Extensions. In the Extension box that will appear, select 
Image Analysis and TIFF 6.0 Image Support. These extensions are 
needed to work with “raw” image features such as satellite images. 
Press OK to activate the extensions. Go back to the View window 
(called View1) either by clicking directly on it or by clicking Open in 
the project window. Now you should add the image you have just 
scanned. To add the file to the view either click the Add Theme 

button  or selecting Add theme under the View menu. When the 
Add theme box appears, navigate to your directory where you saved the image. For the file to 
appear, you have to choose Image Analysis Data Source as Data Source Type.
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1. Navigate to
your directory.

3. Select the file
and click OK (or
doubleclick).

2. To display the file you must
choose Image Analysis Data Source.

If you can not see the file
in the left box you must 
choose Image Analysis 
data Source as data 
source type. If this option
is not available (only 
Feature Data and Image 
Data appear) you have 
not activated the 
extensions. Return to the 
project window and do 
the steps as outlined 
above to activate 
extensions.

When the Theme containing the image appears, click in the check box to turn it on. If you are 
not satisfied with how the image looks you can double click in the legend field to activate the 
legend editor and use the brightness and contrast controls to change the looks of the theme. 

The theme with the scanned image is not a usual GIS shapefile in the sense that the program 
does not the co-ordinates of any points in the theme. To make the image useful for any 
analysis, you must therefore give the program some co-ordinates that it can recognise. In the 
directory earth2/_Sharedfiles/Geoinformatik/data/Arbetsstuga2000/arcview/metria/rodakartan
are themes covering the same area as the SPOT image. These themes are ArcView shapefiles 
with geographic locations on all points stored in the data structure. You must thus add a 
couple of these that you will use to align the image with the known co-ordinates of the 
themes from röda kartan. You should choose themes with features that are possible to 
recognise from the image. The themes with lakes (Rt_sj92), main roads (Rt_av), minor roads
(Rt_ev) and power lines (Rt_kl88) are good for this purpose. N.B. If you can’t find the 
themes from Rodakartan in the Add theme dialogue box, you probably need to change the 
Data Source Type back to Feature Data Source. Use the Add theme button and navigate 
to the directory given above and add the themes. (You can add all themes at once by holding 
down the shift button as you select more than one theme.) When the themes from röda kartan 

are turned on in the view, click on the Zoom to Full button . The view has only a small 
dot which is the themes from röda kartan and the image is not displayed anywhere. 

After pressing the 
Zoom to Full 
button the View 
will look 
something like 
this. Don’t worry, 
it is normal and is 
explained below.
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The reason it only appears a small dot on the View is that the program does not know the co-
ordinates of the SPOT image and thus does not know where to place it in the view. To correct 
this, the first thing you should do is to set the scale of the View, by going to the View menu 
and choose Properties. In the box that appears, set Map and Distance units to meters. This 
will not make the view look better but is the first step.

When you are now going to start the alignment process, there are a few new functions in the 
Image analysis extension module that you are going to use. One of them is the Align tool. 

Make the image theme active and click on the Align tool button . ArcView now tries to 
align the separate themes and the result is that the image and the other themes are displayed in
the view. However, the program still does not have any co-ordinates for the image. You are 
now going to use recognisable points in both themes to correlate points in the different 
themes. Look at the image and try to find the long, narrow lake at the top of the image and 
then look in the lakes theme to find the same lake. 

Identify the
long, narrow
lake in the
image.

Find the same lake in the
lakes theme.

As you can see 
when you have 
identified the lake 
in both themes, the 
two themes are 
approximately at a 
90-degree angle to 
each other. Use the 
Rotate Image 

button  to adjust
the position of the 
image (the image 
has to be the active 
theme).

Pressing the Rotate Image button will rotate the image 90 degrees clockwise. When you 
have done that the image and them themes from röda kartan are roughly positioned in the 
same direction. 

Now that the themes have approximately the same orientation, you should use the Align 
button to select points on the image that you will correlate to the same point on the lake 
theme. Hint: use easily recognisable points such as bays of the lakes. To select the points, 
make the image the active theme and click on the Align button. When you designate the 
correlation points you must first choose a point on the image and then select the 
corresponding point in the lake theme. Use the zoom functions to zoom in and out to help 
you set the control points with higher accuracy.
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When you are working with the Align tool,
you can use the right mouse button to zoom
and pan. Just hold it down and put the cursor
over the command you want to execute.

1. Click on a
recognisable point
in the image.

2. Move the cursor to the same
point in the lakes theme. Click
with the left button to set the
point.

When you have selected the 
Align tool, use the left mouse 
button to click a point in the 
image theme. Then move the 
cursor to the same point in the 
lakes theme and click again in 
the view. Now you have told 
ArcView that the two selected 
points have the same 
geographical position i.e. the co-
ordinates of the point in the lake 
shapefile is transferred to the 
point in the image theme. 

Setting the first point will only give ArcView the location of one point on the SPOT image. 
The second point will give a scale between those two points and the correlation between the 
image and the themes from Rodakartan will be quite good near those two points. In other 
parts of the view, the correlation will still not be good. You must therefore set points in 
different parts of the map. Ideally, the control points should be spread out over the image, 
otherwise the area without control points will not be rectified with high accuracy. This SPOT 
image however, has very few recognisable points in the upper right corner. (You can try and 
set control points there but it is not easy!)

Hint: It will be easier to see some of the points in the lakes if you make the only the outline of
the lakes visible. To do this, make the lakes theme active and double click on the legend 
symbol. In the palette toolbox that appears first click on the Bucket palette and set the 
colour to transparent. Then click on the colour palette (with the paintbrush symbol) and in 
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the Color drop down menu, choose outline. Try also to look at e.g. the intersection points of 
roads and see if you can use those as control points.

Select at least four control points with the method described above. After the fourth control 
point is set you can see how accurate your rectification has been. At the bottom of the 
ArcView window the RMS value (Toot Mean Square) is displayed. 

 This value represents the

error in distance, measured in pixels, between the input location and the rectified location. A 
low value means a better rectification. Try to get a Total RMS value of no more than 3 (less 
than 2 is good). If your RMS value is high, you can delete control points with a high error. 

Use the pointer tool  to select a point.  Hold down the mouse button and drag the point to 
its new position. You can also delete control points by selecting a point and pressing delete.. 

With the Align tool active, there are several functions available 
by using the right mouse button. All zoom functions can be 
used, which allows you to zoom while setting control points. 
You can also pan in the image. The Pan to Next Link function 
not only puts the next (in the order you created the control 
points) link in focus but also selects the point and displays its 
RMS value. In the bar showing the RMS errors, there are two 
values. The first represents the currently selected link and the 
second value the total error. The total error can be affected quite
much by a single bad link. Use the Pan to Next Link button to 
View the RMS for the control points. When you find one point 
with a higher error than the total you can delete that point. If it 
is a high error for that single point, it is likely that you will get a
much better total value.

When you are satisfied with your alignment, you can have a look at another type of image. In 
the METRIA folder, there is an ortophoto stored as a shapefile. Navigate to 
earth2/_Sharedfiles/Geoinformatik/data/Arbetsstuga2000/arcview/metria/ortofot and add the 
theme. (You must change the data source type to Image data source to display it.)

The theme will be placed above the other themes but will not be turned on so you must click 
in the checkbox to turn it on. Place the ortophoto above the SPOT image but below the other 
themes (the line and polygon themes will not be visible otherwise). As you can see the 
ortophoto covers only a small area of the SPOT image. Make the ortophoto the active theme 

and click on the Zoom to Active theme button . The resolution of the ortophoto is as 
you can see, much higher than the SPOT image. Individual trees are actually distinguishable 
whereas the original SPOT image has a resolution of 20 metres and can not display individual
features of less than that. Move around in the ortophoto and notice the correlation of the road 
network between the road theme and the ortophoto. It is not always a perfect match. Then the 
question is which theme is the more accurate. If you look at how the lines representing roads 
are drawn in the shapefile from röda kartan, you can see that they do not follow the roads 
exactly, e.g. the curves are not smooth. The reason being that röda kartan is made from remote
sensing sources such as aerial photos and ortophotos and scanned or digitised much in the 
same way as you are doing now (with higher accuracy of course). 
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Now you are finished with the first part of the rectification. You should now set the Image 
Analysis Properties so that the properties of the original satellite image are stored in the 
shapefile. Make sure that SPOT image is the active theme. Go to the Image Analysis menu 
and choose Properties. In the Analysis Extent drop down menu, choose Same as Spotim. 
The theme's co-ordinates will then be displayed in the Left, Top, Bottom and Right boxes. 
In the cell Size box, type 20 to resample the image to 20meters. (you can now see the 
number of Rows and Columns appear below the size box.) If the letter to the right of the Size 
box is not “m” you must go to the View Properties menu and set Map and Distance units to
metres. Click OK to finish the rectification. 

You are now finished and should save the SPOT image. Go to the theme menu and choose 
Save Image As. When asked if you want to save the control point links to the shapefile, 
click No and then navigate to your working directory and save the file as RectifiedSPOT. In 
the next box that appears, click Yes to add the rectified image to the view. When the new 
theme appears, place it between the original SPOT image and the ortophoto by dragging it 
down. 

To compare the unrectified original (Spotim) with the RectifiedSPOT theme you should 
zoom in to a level where you can see individual pixels. Start with the original and notice the 
alignment of the pixels, as you will see they are not angled slightly. Also use the measure tool 
to measure a single pixel. Notice that a side of the pixel is a little more than 20 metres. Now 
do the same thing with the RectifiedSPOT. In this theme the pixels are aligned north-south 
and their size is exactly 20 by 20 metres. 

Now this exercise is finished. Write down the filename RectifiedSPOT and the path to it, as 
you will use the theme in a future exercise. 
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